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Introducéo

A andlise das redes sociais € uma ferramenta que nos permite conhecer as interac¢des
entre qualquer classe de individuos, partindo preferencialmente de dados qualitativos do que
quantitativos.

Uma vez que a analise das redes sociais requer informacédo de tipo qualitativo, devido as
suas caracteristicas préprias, torna-se necessario seguir uma série de técnicas que nos
permitam ordenar as interacc¢des (informacao) dos individuos de modo a que essas interac¢oes
possam ser representadas num grafico ou rede.

Assim, as redes ou gréaficos constituem uma ferramenta importante para representar as
interac¢Oes entre individuos ou grupos de individuos de forma ilustrativa e agradavel.

No entanto, o simples facto de representar graficamente as interac¢des de um grupo de
individuos nem sempre é suficiente para estabelecer uma analise em profundidade de cada
individuo dentro de uma rede e do grafico em geral.

De facto, as caracteristicas Unicas de analise das redes sociais fazem com que as
ferramentas estatisticas habituais ndo sejam de todo adequadas para a analise e compreensao
das mesmas.

No entanto, diversos investigadores de diferentes partes do mundo tém desenvolvido
instrumentos mateméaticos especificos para a andlise das redes sociais, ferramentas que
permitem criar os indicadores capazes de explicar a estrutura de uma rede, tanto no seu
conjunto como individualmente.

A estrutura de uma rede pode ser analisada com recurso a diversos indicadores,
dependendo dos resultados pretendidos com a analise.

Os indicadores de centralidade permitem-nos analisar a rede tanto no seu conjunto como
individualmente, encontrando diversos resultados: grau de conectividade da rede, individuos
com o maior e menor nimero de interacgdes, intermediacdo de alguns actores nas relagfes
entre individuos e a proximidade entre os individuos através das suas interaccdes.

O presente manual pretende explicar, de uma maneira simples, o uso apropriado da
informacao relacional, recorrendo a exemplos de diversos grupos de individuos, através de
ferramentas computacionais, analiticas e graficas adequadas para que a andlise das
interaccdes entre os individuos nos permita interpretar a importancia da rede, dos seus actores
(ou nés) e das suas interacgdes por meio de alguns dos principais indicadores de centralidade

na analise das redes sociais.
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Objectivos

Conhecer o significado de uma Rede e suas componentes.
Construir matrizes na plataforma UCINET 6.109.
Representar graficamente as matrizes com NETDRAW 2.28.
Agrupar atributos individuais dos actores de uma Rede.

Criar e interpretar cinco Indicadores de Centralidade.

o g~ w DN PE

Gerar Redes e Atributos mdltiplos.

1. Definicao de Rede

Entende-se por Rede um grupo de individuos que, de forma agrupada ou individual, se
relacionam uns com o0s outros, com um fim especifico, caracterizando-se pela existéncia de
fluxos de informacéo. As redes podem ter muitos ou poucos actores e uma ou mais categorias
de relagBes entre pares de actores. Uma Rede € composta por trés elementos basicos: nds ou

actores, vinculos ou relages e fluxos.

1.1. Elementos basicos de uma Rede

Nés ou actores: sd0 as pessoas ou grupos de pessoas que se agrupam com um objectivo
comum. Na Figura 1 temos as interac¢gbes ocorridas entre os intervenientes num férum de
discussao online, onde cada actor constitui um no, sendo que “A” representa um aluno e “P”
um professor. Habitualmente, os nds ou actores representam-se por circulos. A soma de todos
0s nos indica o tamanho da Rede.

Vinculo: sdo os lagos que existem entre dois ou mais nds. Nesta rede exemplificada, um
actor estabelece um vinculo directo com outro actor. Os vinculos ou relacdes representam-se
com linhas.

Fluxo: indica a direccdo do vinculo que se representa com uma seta mostrando o sentido.
Retomando o exemplo do nosso férum online (Figura 1), estes fluxos podem ser
unidireccionais (no nosso exemplo, AO8 interage com A02, mas AO02 n&o interage com A08),
ou bidireccionais (Al10 interage com All e vice-versa). Quando um actor ndo estabelece
gualquer tipo de fluxo, o que por sua vez indicia a auséncia de vinculos, diz-se que o no esta
solto dentro da Rede (como os nds A04, A07, A13 ou A15).

Medidas de Centralidade 2



® A04 A01

° ; - )
A07 NGs soltos . Fluxo Bidireccional
® Al13 O
® Al5
AO03
%,
x “
N6
Vinculo

Fluxo Unidireccional

Tamanho da Rede: 11 nés

Figura 1 — Elementos basicos da Rede de Interac¢bes

Agora que fizemos uma breve explicacdo das componentes de uma Rede, continuaremos
com o uso do UCINET 6.109' e NETDRAW 2.28° que serdo de grande ajuda para realizar a

andlise e a visualiza¢do dos nossos exemplos.

2. Plataforma do software Ucinet 6.109

A representacao das interac¢fes entre os diferentes actores de uma Rede faz-se por meio
de gréficos, como o anterior, 0s quais se tornam mais compreensiveis e com uma
representacdo mais agradavel para a sua interpretacdo; mas cada grafico resulta de uma
matriz® na qual se introduz previamente a informacéo de que se dispde.

Para criar uma matriz com a finalidade de analisar os dados e poder ilustra-los, recorremos
a um programa chamado UCINET, do qual se pode obter uma versédo de experimentacdo na

pagina: http://www.analytictech.com/ucinet 5_description.htm. Uma vez instalado o programa,

podemos inicia-lo com o seguinte percurso: Inicio > Programas > Ucinet 6 for Windows e na
janela inicial do programa observamos o seguinte:

! Borgatti, S. P., Everett, M. G. e Freeman, L. C. (2002). Ucinet for Windows: Software for Social Network Analysis.
Harvard, MA: Analytic Technologies.

2 Borgatti, S. P. (2002). NetDraw: Graph Visualization Software. Harvard: Analytic Technologies.

% Conjunto quadrado de elementos dispostos em linhas horizontais (filas) e verticais (colunas).
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Figura 2 — Janela inicial do Ucinet 6.109

O UCINET é um programa que apresenta caracteristicas similares a outros programas que
funcionam no sistema operativo do Windows. Na Figura 2 — Janela inicial do Ucinet 6.109,
também podemos observar que, na parte superior, existe uma barra de menus (File, Data,
Transform, Tools, Network, Draw, Options e Help), a qual se segue uma série de icones de
acesso directo e, por ultimo, na parte inferior, encontra-se uma barra de “endere¢o” que nos
indica o directério em que se esta a trabalhar e onde automaticamente se vao guardando todos
0S arquivos que se criam.

Para construir a matriz onde se introduz a informacgéo, pressionamos o segundo icone a
contar da esquerda para a direita, que se refere a funcdo da Folha de Calculo (Spreadsheet),

(Figura 3), aparecendo um ecra, como na Figura 4, no qual podemos comecar a introduzir os

dados.

=i |
- ot A L o e e o A [ |
PEE T LT N PR SR S — ;I:M'::I_'HEJ"- | : i
Al asd Dot gatPropiietiiisl =] T !
Figura 3 — icone da Folha de Calculo Figura 4 — Janela da Folha de Calculo

Uma vez aberta esta janela (Figura 4), e para poder criar a nossa matriz, comegaremos
primeiro por identificar as ferramentas essenciais que esta contém (Figura 5).
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Figura 5 — Identificac&o das ferramentas principais da matriz

Do lado direito da Figura 5, ampliada na Figura 6, podemos ver a “Célula actual” (Current
cell), as “Dimensfes da matriz” (Dimensions) e o “Modo” (Mode) da matriz (Normal/Symmetric).
A primeira indica em que célula estamos a introduzir os dados; a segunda, o niumero de filas e
de colunas que compdem a matriz. No nosso caso, temos tanto em Rows (filas) como em Cols.
(colunas) o valor de 16, ja que este é o tamanho da Rede do exemplo com o qual comegamos

a trabalhar, ou seja, 0 nUmero de actores com os quais iremos exemplificar (Figura 1).

Current cell:
Raw:  Cal

ol

Dimersions

Rows:  Cols:

e [

M ode:
¢ Mormal

" Symmetric

Figura 6 — Ferramentas principais para a criacdo da matriz de informacéo

Antes de continuar, importa salientar que o valor que utilizaremos tanto em filas como em
colunas deve ser idéntico; isto &, iremos construir uma matriz quadrada®.

Do mesmo modo, no nosso exemplo, a matriz é ndo s6 quadrada, como também uma
matriz idéntica®, ja que introduzimos 0 mesmo nome do actor tanto na coluna como na fila.

Por fim, 0 modo da matriz corresponde ao tipo de fluxos que se estabelecem entre os
vinculos dos nés, quando falamos de uma matriz normal temos Fluxos unidireccionais e
bidireccionais dentro da Rede; e quando temos uma matriz simétrica®, s6 encontramos

fluxos bidireccionais.

* Matriz que contém o mesmo ntimero de filas e de colunas.
® Matriz em que o nimero e os nomes das colunas e das filas s&o iguais.
® Matriz onde as relac@es entre os nés s6 ocorrem de maneira bidireccional.
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3. Introduzir dados numa matriz do Ucinet

Antes de comecar a introduzir os dados na matriz, iremos rever as interac¢des que cada
actor tem com os restantes nés. O Quadro 1 demonstra de uma maneira simples as

interaccfes que existem entre os actores.

Actor Interaccoes
AO01 A02, A05, A09, P01

A02 A01, A03, A06, A09, Al11, A12, P01
A03 A02,

A04 Nenhuma

A05 A01, A02, A12, Al4, PO1

A06 A05

AQ07 Nenhuma

A08 A02, Al4, PO1

A09 A01, A02, A12

Al10 All, A12, PO1

All A02, A10

Al2 A02, A09 P01

Al3 Nenhuma

Al4 P01

Al5 Nenhuma

PO1 A01, A02, A03, A05, A06, A0S, A10, All, Al12, Al4

Quadro 1 — Resultado das interac¢cdes entre os actores

Introduziremos as relagdes do Quadro 1 na matriz e esta deve ter uma caracteristica
importante, ser idéntica; ou seja, as filas e as colunas deverdo ser iguais, por isso,
registaremos 0s nomes dos nossos actores tanto nas colunas como nas filas, segundo a

mesma ordem (Figura 7).

[+ LICIHET Sproadshest - wntitled

Fe Edi% Trargform Fl Lesbely Optors Help
(O] @) (3] )R] ml -0 o
1 1 1T T 1T 1T T T | fComo
| A0 Fosr  Cot
|.-'*.I]2‘ ,'.'l_ !I.I_
E]
[And
3 [ieenziors
|An6 Fowms Lol
(A7 e 16
[ADE
. s
= . ¥ Mowmal
H Yo
ATl
(A1
A1
[P
|vr * |

— _ |
Pugs 1 |

Figura 7 — Introducé&o dos nomes das filas na primeira coluna

Para facilitar este procedimento e evitar erros no momento de registar os nomes dos nés
ou actores, podemos introduzir todos os nomes na primeira coluna (Figura 7) e depois seguir
este caminho: Labels > Copy rows to columns (Figura 8). Assim, os titulos das filas serdo os

titulos das colunas (Figura 9).
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Kl |
A4 |
| £
P |
I% »
Page1 |

Figura 8 — Copiar os nomes das filas para as colunas

=] UCINET Spreadsheet - untitled

Fle Edt Trarsfom Al Labels Opbons Meb
D)= =)&) =2 ]5]E] ) -of -o|ned
[_Jaonlanzlaos]ans|ans [aos|aor [aos |aos a0 |an [aszlatafara]ars|Pon]| - Curentcot
e Ao Cot
= =
| A0

(a5 Diaraicns
|| Flows: ol
o o e
ADE

Ah Mode:

AlD :

[AiZ] Ty
A1

IAid]

OH

(o]

Pags 1

Figura 9 — Registo dos nés numa matriz

Agora que registdmos o nome de cada nd, podemos comecar a introduzir as relagbes entre

N a

0s actores, neste caso, dando o valor “1” a existéncia de interaccdo e “0” a ndo existéncia dela.
E importante clarificar que, habitualmente, ndo é possivel atribuir o valor de “1” & célula que
pertence ao mesmo nd. No entanto, isto é possivel sé quando a andlise assim o requer.
Também ndo devemos dar valores maiores do que “1”. Contudo, h& que referir que, nalguns
casos, podemos utilizar valores maiores do que “1” mas s6 quando se trabalha com redes
ponderadas. Neste caso, s6 utilizaremos valores de “0” e “1".

Deste modo, para facilitar o registo dos dados e evitar erros, preenchem-se as células que

pertencem ao mesmo n6 com “0” (Figura 10).
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File Edit Transform Fill Labels Options Help

A01]A02 [A03 |A04 [A05 [A06 [A07 A0 [A03 [A10]A11[Aa12 [A13 [A14 [A15 P01 Current cell:
A0l 0 Row:  Cal:
Al2 0
fmdded] 1] 1]
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Al4 0
ADE 0 Dimensions
AlB 0 Rows: Cals:
ADT 0 16 16
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— Mode
% 0 0 &+ Mormal
A2 0 ™ Symmetric
Al3 0
Al4 0
Alb 0
P01 0
Page 1

Figura 10 — Evitando erros de registo de dados na matriz

Agora que temos preparada a nossa matriz, evitando quaisquer erros de registo,
comecaremos com a leitura do quadro anterior (Quadro 1), atribuindo o valor de “1” as relagfes
existentes, fazendo isto de fila a coluna, ou seja, em cada fila registamos as relagdes que cada

no diz ter com os restantes (colunas), nunca devera ser de outra forma (Figura 11).
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DG [} Hewr  Cnlr
ANT o 16 16
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All ] 5 .
ATZ 0 i
ATS 0
Ald 0
ATS 0
P 0
Page1 |

Figura 11 — Registo das primeiras relacdes na matriz

Tendo clarificada a forma como se deve registar as relagdes, prosseguiremos realizando o

mesmo procedimento para cada actor (Figura 12).

Medidas de Centralidade 8



[T UCINET Spreadsheat - untitled

Fle FEdt Transform Al Labels Opbors  Help
DIB"'IHI gm X Iﬂnllﬂl Fil |« <11 Frer

oo [ane |ao3|ana (a5 |a0s [aoT|ans [aoafatn[an [arz |arsfata[ais(Pon ]| - Covercot
EEl I 1 1 3 T 5
ARl 1 0] 1 1 1 11 1 e
A3 1 0
LA | a p—
Al 1 1 1] 1 1 1 Dimensions
Alls 1. 1 Fiows: Coli:
LT o [ [E
LIG] 1 L] 1 1
Apg] 11 i 1

Mode

e 0 1 1 1 i Himal
Al 1 1 0 RS
Al | 1 i 0 1 1 Symmatic
A13 0
A4 ] i
A5 0
POAy 1] 1] 1 1 1 1 1 1 1 i 0
Page 1 |

Figura 12 — Registo de todas as rela¢des na matriz

Apo6s ter registado todas as relagbes encontradas na Rede, podemos fazer uma breve
interpretacdo em relacéo as filas e as colunas.

Como foi referido anteriormente, as filas representam as interac¢fes que cada actor tem
com os restantes nés e as colunas séo as interac¢des que 0s outros nds tém com um actor.
Podemos, desde j4, considerar que 4 actores nédo estabelecem interac¢des (A04, A07, Al3,
A15), que o professor (P01) interage com 10 alunos (nés) e 7 alunos (nés) interagem com o
professor (P0O1).

Apo6s esta explicagéo do significado das colunas e filas, “preenche-se” com “0” as células
com auséncia de relacdo, pressionando o icone Fill, que se encontra na quarta posicdo

contando da direita para a esquerda (Figura 13).
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Figura 13 — Preenchimento das células em branco com a ferramenta Fill
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Depois de ter a matriz completa, podemos guarda-la utilizando os seguintes passos: File >
Save as (Figura 14), definimos um nome para a matriz, neste caso “Rede de interaccdes” e

depois de termos guardado a matriz no computador, podemos fechar esta janela.
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Figura 14 — Guardar uma matriz

Para poder copiar ou transferir os ficheiros que se criam no UCINET ou para transporta-los
para outros computadores, devemos copiar um ficheiro com a extensdo “.##h” e outro ficheiro
com a extensdo “.##d”, porque se sO se copiar um dos dois, ndo se pode visualizar o grafico
nem sequer abri-lo. No nosso exemplo, teremos de copiar os ficheiros “Rede de
interaccdes.##h” e “Rede de interac¢bes.##d".

Também é possivel construir matrizes no Excel, o que é especialmente recomendado no
caso de matrizes com um tamanho consideravel de ndés. Para tal, basta seleccionar a
informacdao “copiar” e “colar” na Folha de Calculo.

Neste momento, completamos a primeira parte que diz respeito ao UCINET: a preparacao
de uma matriz e o registo dos dados da mesma. Prosseguimos com 0 passo seguinte: ilustrar a

matriz num grafo’.

4. Construir um grafico da Rede com NetDraw 2.28

O primeiro passo para poder analisar uma Rede é construir um grafico; para fazé-lo, no
UCINET, pressionamos o primeiro icone a contar da direita para a esquerda (Figura 15). De
seguida, surge o ecra inicial do NETDRAW (Figura 16). Este programa apresenta também
caracteristicas similares a outras do sistema operativo do Windows, com uma barra de menus,

barra de icones de acesso directo, janelas flutuantes, etc.

" Nome técnico de um grafico que mostra as relacdes entre um grupo de actores (Rede).
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Figura 15 — Iniciar o NetDraw 2.28
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Figura 16 — Janela inicial do NetDraw 2.28

Para poder trabalhar € necessério abrir a matriz criada anteriormente, e para o conseguir,
pressionamos 0 segundo icone a contar da esquerda para a direita: Open UCINET Network
Dataset (Figura 17).

3] NetDraw 2.28 - Network Visualization Software
File Layout Properties Analysis Transform Options Help

D @@ L3 0 B L3 G PCMS § ¥-ise Ren MC|

Figura 17 — Procedimento para abrir a matriz guardada

O programa mostra um quadrado onde podemos procurar o nome do ficheiro,
pressionamos o botdo “com pontos de reticéncia”, procuramos a pasta onde esta guardada a
matriz, seleccionamos, pressionamos “Abrir” e por fim, “OK” (Figura 18). Imediatamente, o

programa fard uma representacgédo grafica da Rede (Figura 19).
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Figura 19 — Representacao grafica da Rede de interac¢cdes

Por vezes, a representacéo podera ndo estar perfeitamente legivel nesta primeira tentativa,
como no exemplo da Figura 19 onde pode parecer que Al2 ndo interage com AQ9, devido a

posicdo de AOl, o que ndo corresponde a verdade. Por isso, os nés podem ser movidos

clicando no botéo esquerdo do rato sobre o0 n6 e arrastando-o para a posi¢ao desejada.
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Figura 20 — Forma manual de ajustar os n6s numa Rede
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Neste grafico podemos observar os diferentes vinculos entre os nés ou actores, oS
diferentes fluxos unidireccionais (A06 para A05, A08 para A02, etc.), bidireccionais (entre A10 e
All, AO8 e P01, etc.) e também o0s que ndo interagem com ninguém nem ninguém interage
com eles (A04, A07, A13 e Al5).

Agora, para podermos visualizar um gréafico que distinga um n6 do outro, recorreremos a
caracteristicas atributivas (idade, sexo, profissdo, etc.), que devem ser registadas de maneira
similar, como se fez com a matriz anterior, mas seguindo outro procedimento que

continuaremos a explicar.

5. Introduzir caracteristicas atributivas (Atributos dos
nos)

Para poder introduzir os atributos® dos nos ou actores, abrimos a Folha de Calculo
(Spreadsheet) do UCINET (Figura 3); neste caso, vamos introduzir o atributo “género”.
Voltamos a abrir a matriz (“Rede de interac¢bes”) e reduzimos as colunas para 1 (mas ndo as
linhas, que se mantém com o valor de 16) e eliminamos os valores que pertencem a matriz.
Agora, muda-se o titulo da coluna para “género” e introduzimos o valor “1” para masculino e “2”

para feminino (Figura 21).
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Figura 21 — Atributo “Género” para cada actor

Por fim, guardamos o ficheiro: File > Save as, mas agora com o nome “Rede de interac¢des
(Género)". Depois de termos definido 0 nome e guardado o ficheiro, podemos fechar a janela.
Com este atributo, sera mais facil poder visualizar o grafico da Rede e tirar conclusGes mais

precisas da nossa primeira analise.

8 Os atributos de um né sdo caracteristicas que nos permitem identificar cada actor ou grupo de actores e, assim,
diferencia-los uns dos outros.
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5.1. Grafico da Rede com atributos

Para ver o gréafico da Rede, voltamos ao NetDraw com o gréafico aberto (nunca se fecha):
pressionamos o terceiro icone a contar da esquerda para a direita, Open UCINET attribute
dataset (Figura 22); mais uma vez, o programa abre uma janela que nos pede o nome do
ficheiro, pressionamos o botdo com os “pontos de reticéncia”; localiza-se o ficheiro “Rede de

interac¢cbes (Género)”, clicamos em “Abrir” e depois em “OK” (Figura 23).
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Figura 22 — icone para abrir a janela e juntar atributos a Rede de interac¢des
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2-Mode Metwork,
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o 0K
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Figura 23 — Carregar os atributos para a Rede

Para poder visualizar a Rede com os atributos, pressionamos o quarto icone da direita para
a esquerda, Choose node colors according to attribute values (Figura 24); abre-se uma janela
Color nodes by attribute onde aparece a palavra Select, procuramos o atributo “Rede de
interaccBes (Género)” e vemos que as cores dos nos estao de acordo com os atributos de cada
actor (Figura 25).

Uma das possibilidades que o NetDraw nos oferece para visualizar os graficos é a mudanca
das cores dos nés, que se pode fazer clicando no quadrado das cores dos atributos (vermelho e
azul, neste exemplo — Figura 25) e, de imediato, o programa abre o painel de cores onde se

pode escolher aquela que mais nos agradar.
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Figura 25 — Mudanc¢a da cor do n6 de acordo com os atributos

Se desejarmos dar outra apresentacdo e uma melhor diferenciagdo aos nossos nés ou
actores, também podemos mudar a forma do n6é de acordo com o atributo. Para isto,
pressionamos o icone Choose node shape according to attribute values (Figura 26). Do mesmo
modo, como no anterior, abre-se uma nova janela “Shapes of nodes”, seleccionamos o atributo

e pressionamos “Enter”. Agora, podemos ver que as figuras dos nés trocaram (Figura 27).
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Figura 26 — Procedimento para mudar a forma dos nds de acordo com o atributo
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Figura 27 — Mudar a forma dos nés de acordo com o atributo

Também podemos trocar o tipo de forma que mais nos agradar, seguindo 0 mesmo
procedimento para trocar a cor s6 que, neste caso, temos de abrir o menu das formas
disponiveis e uma vez seleccionada a forma desejada, carregamos no “Visto”.

Ha alturas em que é necessario guardar o grafico da Rede, por exemplo, para uma
apresentacdo. Para poder fazer isto, seguimos o caminho File > Save diagram as > Jpeg.
Também ha a possibilidade de guardar o ficheiro em BMP e/ou Metaficheiro, mas é
aconselhavel ser em Jpeg por ocupar menos espaco no disco e por manter uma boa resolugéo
das imagens.

Até agora, s6 realizamos uma analise gréfica da “Rede de interac¢des”. Mas, para termos
analises mais detalhadas das caracteristicas da Rede e de cada uma das suas componentes,
teremos que recorrer & andlise dos indicadores de Rede.

Estes indicadores podem ser calculados de forma individual (para cada né) ou de forma
conjunta (para toda a Rede).

O Quadro 2 mostra os tipos de indicadores que veremos neste manual e a sua utilizagédo

individual ou colectiva.

. — Rede ‘o
Tipo de indicador Actor Completa Descricéo

Mostra-nos o valor em percentagem da Densidade da Rede,

isto é, mostra-nos a alta ou baixa conectividade da Rede. A
Densidade Sim Sim Densidade é uma medida expressa em percentagem do

guociente entre o numero de relagdes existentes com as

relagdes possiveis.

O Grau de Centralidade consiste no niumero de actores com 0s

quais um actor esté directamente relacionado.

Centralidade Sim Nao

Trata-se de uma condig¢do especial na qual um actor exerce um

Centralizacéo N&o Sim N
& papel claramente central ao estar altamente conectado a Rede.

Trata-se da possibilidade que um actor tem para intermediar as
Intermediagéo Sim Sim comunicagdes entre pares de nos. Estes nés sdo também
conhecidos como "actores-ponte".
Trata-se da capacidade de um actor para alcancgar todos 0s nds
da Rede.

Quadro 2 —Tipo de indicadores

Proximidade Sim Sim
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6. Indicadores de Redes

6.1. Densidade

A Densidade (Density) de uma Rede pode ser calculada sem necessidade de usar o
software. Calcula-se dividindo o nimero de relagbes existentes entre as possiveis e
multiplicando por 100 [D = RE / RP x 100]. O calculo do total das relagbes possiveis faz-se
multiplicando o nimero total de nés pelo niumero total de nés menos 1 [RP = NTN x (NTN - 1)].

Na nossa “Rede de interac¢des”, ha um total de 16 nos e 42 relagbes de 240 possiveis [RP
=16 x (16-1) = 16 x 15 = 240]. A Densidade da Rede é de 17,5% [D = 42/240 x 100=17,5%].

Agora, se quisermos calcular a Densidade do actor A02, temos: 15 relacBes existentes de
100 possiveis (tanto de entrada como de saida), pelo que 15/ 100 x 100 = 15%.

Apo6s termos calculado a Densidade da Rede e conhecermos a alta ou baixa conectividade
da mesma, passaremos a calcular o proximo indicador, que nos mostra a quantidade de

ligagBes que um actor possui.

6.2. Grau de Centralidade

O Grau de Centralidade (Centrality Degree) é o nimero de actores aos quais um actor esta
directamente ligado. Este divide-se em Grau de Entrada e Grau de Saida dependendo da
direccao dos fluxos.

e O Grau de Saida é a soma das interaccdes que os actores tém com os outros. Por
exemplo, na nossa “Rede de interacgfes”, podemos ver que A02 interage com 7 nés, logo, o
seu Grau de Saida é 7.

e O Grau de Entrada é a soma das interac¢des que 0s outros nés tém com o actor. Por
exemplo, 8 nds interagem com A02, logo, o seu Grau de Entrada é de 8.

Mas, se quisermos que o UCINET calcule para cada né o seu Grau de Centralidade (de
entrada e de saida), o procedimento é o seguinte:

1. Na barra de menus, seguimos o caminho Network > Centrality > Degree (Figura 28).

2. Na Rede que aparece, abrimos “Rede de interac¢Bes” e pressionamos “Abrir”.

3. Na caixa “Treat data as symmetric’ mudamos “Yes” para “No” (recordamos que
estamos a trabalhar com uma Rede assimétrica) (Figura29).

4. Pressionamos “Ok” e imediatamente abre-se uma nova janela com os indicadores
solicitados (Figura 30).

5. Estes indicadores podem ser copiados: Edit > Copy e/ou guardados: File > Save As.
(Figura 30).
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Figura 29 — Op¢des do Grau de

Centralidade

Figura 31 — Guardar os dados do
indicador

Nos resultados mostrados pelo UCINET podemos observar os actores ordenados pelo seu

Grau de Centralidade. Encontramos, também, quatro colunas (Quadro 3).

Nome da coluna

Significado

1. OutDegree
2. InDegree
3. NrmOutDeg

4. NrminDeg

Grau de saida
Grau de entrada
Grau de saida normalizado

Grau de entrada normalizado

Quadro 3 - Significado das colunas na analise de centralidade

Medidas de Centralidade
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Grau de Grau de | Grau de Saida | Grau de Entrada
ID Saida Entrada Normalizado Normalizado

PO1 10.000 7.000 66.667 46.667
A02 7.000 8.000 46.667 53.333
A05 5.000 3.000 33.333 20.000
A0l 4.000 4.000 26.667 26.667
A09 3.000 3.000 20.000 20.000
A10 3.000 2.000 20.000 13.333
Al2 3.000 5.000 20.000 33.333
A08 3.000 1.000 20.000 6.667

All 2.000 3.000 13.333 20.000
AO03 1.000 2.000 6.667 13.333
A06 1.000 2.000 6.667 13.333
Al4 1.000 3.000 6.667 20.000
AO07 0.000 0.000 0.000 0.000

A13 0.000 0.000 0.000 0.000

Al15 0.000 0.000 0.000 0.000

A04 0.000 0.000 0.000 0.000

Quadro 4 — Resultados de centralidade para cada actor

Os resultados da Quadro 4 mostram, o Grau de Entrada e de Saida de todos os nds. As

duas Ultimas colunas, Grau de Saida Normalizado e Grau de Entrada Normalizado, sdo a

representacdo percentual dos referidos graus. Deste modo, podemos dizer que o actor central

desta Rede, em termos de interac¢des recebidas é A02, pois tem um Grau de Entrada de 8 e

um grau de Entrada Normalizado de 53%.

Também podemos ver os indicadores gerais de toda a Rede (Descriptive Statistics),

(Quadro 5) onde se observa a média (Mean) de todas as relac¢des; o desvio padréo (Std Dev),

isto é, a variacdo da média; a soma (Sum) de todas as rela¢des; Minimo (Minimum) e Maximo

(Maximum), que indicam os graus maximo e minimo de interac¢Bes que 0s actores tém dentro

da rede.

Estatisticas Grau de Grau de | Grau de Saida | Grau de Entrada
Descritivas Saida Entrada Normalizado Normalizado
Média 2.688 2.688 17.917 17.917
Desvio-padréo 2.709 2.338 18.061 15.585
Soma 42.000 42.000 286.667 286.667
Variancia 7.340 5.465 326.215 242.882
Minimo 0.000 0.000 0.000 0.000
Méaximo 10.000 8.000 66.667 53.333

Quadro 5 — Estatisticas descritivas gerais do Grau de Centralidade

De entre os resultados do UCINET, no momento de calcular o Grau de Centralidade, temos

outro indicador de grande utilidade para a interpretacédo e analise de uma Rede. Esse indicador

€ descrito a seguir.
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6.3. indice de Centralizac&o

O indice de Centralizag&o (Centralization Index) € uma condi¢éo especial em que um actor
exerce um papel claramente central ao estar ligado a todos os nos, os quais necessitam de
passar pelo n6é central para se ligarem uns aos outros. Para exemplificar melhor, utilizaremos
um exemplo diferente, onde “A” exerce claramente um papel central. Este tipo de Rede indica
que existem actores muito mais centrais do que outros e assemelha-se ao comportamento de
uma Rede em estrela (Figura 32). O contréario, valores baixos neste indicador, indicariam a

auséncia de actores claramente centrais (Figura 33).

de

Figura 32 — Grau de Centralizacdo 100% Figura 33 — Grau de Centralizacdo 0%
(Rede em Estrela)

Importa ainda referir que dentro da analise de Redes existem também graus de
centralizacdo de entrada e de saida, o seu uso dependera das necessidades dos resultados
especificos de cada Rede.

Regressando ao nosso exemplo “Rede de Interac¢Bes”, os graus de centralizacdo de
entrada e de saida obtém-se com base no célculo do Grau de Centralidade (Figuras 28, 29 e
30). Nesta janela com os dados, na parte inferior, podemos encontrar o grau de centralizagéo
de entrada e de saida da Rede:

Hetwork Centralization (Outdegres) = 52 .000%
Hetworlk Centralization (Indegreed = 37 .778%

Agora que temos identificados os actores centrais, prosseguimos com a analise dos nés

que podem ligar os restantes nds, através do calculo do préximo indicador.
6.4. Grau de Intermediacao
Uma razdo para considerar a importancia de um actor recai na sua intermediacdo

(Betweenness). Isto expressa o “controlo da comunicagdo” e interpreta-se como a possibilidade

gue um noé tem para intermediar as comunicagdes entre pares de nos.
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Nesta andlise podemos ainda encontrar caminhos geodésicos® entre todos os pares
possiveis. A medida de intermediacdo de um né obtém-se contando as vezes que este aparece
nos caminhos (geodésicos) que ligam todos os pares de nés da Rede, a estes actores
chamam-se actores ponte.

Assim, para explicar melhor a intermediagdo, utilizaremos outro exemplo. Neste novo
exemplo, com 6 nds (tamanho da Rede), o n6 “A” aparece em todos 0os caminhos possiveis
para que os restantes nés se possam ligar (F-B, F-C, F-D, F-E, B-C, B-D, B-E, C-D, C-E e D-E).
Logo, este actor tem um Grau de Intermediagdo de “10”, enquanto 0s outros actores tém um
Grau de Intermediacao de “0” (Figura34).

Convém referir que, para que um né tenha um Grau de Intermediacdo numa Rede, deve ter
pelo menos um Grau de Entrada e de Saida e estar nos caminhos geodésicos entre os pares
de nés que se querem ligar.

E F
Figura 34 — Grau de Intermediacdo do né A

Agora, se tivermos uma Rede onde cada actor faz referéncia a um dos seus companheiros,
temos uma Rede onde cada n6 tem um Grau de Intermediacdo de “10” e para um nd se poder
ligar a outro, com o qual ndo esta ligado directamente, tem que utilizar os outros como “ponte”

7

para os poder alcancgar. Por exemplo, se 0 n6 “A” se quiser ligar com o n6 “D”, “E” e/ou “F", tera

7

que utilizar como “ponte” o nd “B” (Figura 35).

F

Figura 35 — Exemplo de uma Rede de 6 n6s para calcular o seu Grau de Intermediagao

° Os caminhos mais curtos que um actor deve seguir para se ligar a outros nos.
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Regressando ao nosso exemplo “Rede de interac¢des”, para efectuar a andlise de
intermediacdo com o UCINET seguimos o seguinte procedimento:

1. Na barra de menus escolhemos o caminho Network > Centrality > Betweenness >
Nodes (Figura 36).

2. Na janela que aparece, seleccionamos o nome do ficheiro “Rede de interac¢bes” e
pressionamaos “Abrir”.

3. Pressionamos “Ok” e imediatamente abre-se uma nova janela com os indicadores
solicitados (Figura 37).

4. Estes indicadores podem ser copiados: Edit > Copy e/ou guardados: File > Save as.
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Figura 36 — Procedimento para solicitar o Grau de Intermediacgéo
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Figura 37 — Resultados da analise do Grau de Intermediacéo

Perante estes resultados podemos observar que POl é o actor que detém maior
intermediacéo (48.083), A02, A05, A01, A12, A10, All, A06 e AQ9 apresentam graus menores

e os restantes com um Grau de Intermediac&o de “0”.
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Como podemos observar no Quadro 6, existem dois tipos de Graus de Intermediacéo. Até
agora vimos o Grau de Intermediacdo com numeros totais (1 Betweenness), ou seja, 0 nimero
de pares de n6s que um actor é capaz de ligar. A segunda coluna do resultado mostra-nos o
Grau de Intermediacdo Normalizado™ (2 nBetweenness), que nos indica o Grau de
Intermediacdo em percentagem. Assim, podemos verificar que P01 tem um Grau de
Intermediacdo Normalizado de 22.897%, A02 de 15.278%, AO05 de 5.238% e assim

sucessivamente.

D Grau (_Jle 5 Grau de Inte_rmediagéo
Intermediagao Normalizado
PO1 48.083 22.897
A02 32.083 15.278
A05 11.000 5.238
AO01 4.667 2.222
Al2 3.833 1.825
Al0 2.250 1.071
All 1.583 0.754
A06 0.917 0.437
A09 0.583 0.278
AQ07 0.000 0.000
A03 0.000 0.000
A04 0.000 0.000
Al3 0.000 0.000
Al4 0.000 0.000
Al5 0.000 0.000
A08 0.000 0.000

Quadro 6 — Grau de Intermediacdo dos nos

Mais uma vez, o UCINET da-nos as estatisticas descritivas do Grau de Intermediacéo
(Quadro 7). Estes indicadores interpretam-se da mesma maneira que interpretAmos os
indicadores de centralidade, mas tendo sempre em conta que estes sdo os valores de

intermediacao.

Estatisticas

Grau de

Grau de Intermediacédo

Descritivas Intermediagao Normalizado
Média 6.563 3.125
Desvio-padréo 13.272 6.320
Soma 105.000 50.000
Variancia 176.157 39.945
Minimo 0.000 0.000
Maximo 48.083 22.897

Quadro 7 — Estatisticas descritivas do Grau de Intermediacao

1% Expressao percentual do grau.
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Depois de termos calculado e compreendido o Grau de Intermediacédo, resta calcular o

outro indicador que se reveste de muito interesse na analise e interpretacdo de uma Rede, este

indicador é o Grau de Proximidade.

6.5. Grau de Proximidade

O Grau de Proximidade (Closenness) é a capacidade de um né se ligar a todos os actores

de uma Rede. Calcula-se contando todas as distancias geodésicas de um actor para se ligar

aos restantes. Convém referir que este método (“célculo manual”) s6 resulta com matrizes

simétricas (matrizes onde as relacdes entre os actores se ddo de maneira bidireccional). O

Quadro 8 mostra a maneira mais facil de calcular este indicador. Como exemplo, temos uma

Rede de 11 actores e as distancias geodésicas de cada um.

5

s | 2

A B C D E F G H | J K “.CE =

2] X

a °

o
A 3 2 1 1 2 2 2 2 1 3 19 52.6
B 3 2 4 4 3 4 4 1 2 1 24 41.7
C 2 2 2 3 1 1 2 1 1 1 16 62.5
D 1 4 2 2 1 2 3 3 2 3 23 43.5
E 1 4 3 2 3 3 3 3 2 4 28 35.7
F 2 3 1 1 3 1 3 2 2 |2 20 50.0
G 2 2 1 2 3 1 2 1 1 1 16 62.5
H 2 2 2 3 3 3 2 2 1 1 21 47.6
| 2 1 1 3 3 2 1 2 1 1 17 58.8
J 1 2 1 2 2 2 1 1 1 2 15 66.7
K 3 1 1 3 4 2 1 1 1 2 19 52.6

Quadro 8 — Calculo de Proximidade de uma Rede simetrizada

Figura 38 — Grafico de uma Rede simetrizada, Grau de Proximidade
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Podemos observar que cada actor possui um valor para cada um dos seus companheiros,
este valor é a distancia geodésica para ligar os restantes actores, a soma destes intervalos tem
como nome a distancia. Por exemplo, se quisermos conhecer a distancia de “E” em relacdo a
“C”, terilamos que contar os caminhos que 0s separam, neste caso, a sua distancia geodésica é
de “3" (Figura 38). A proximidade € o contrario e calcula-se dividindo o valor de “1” entre a
soma dos geodésicos (distancia) e multiplicando isto por mil. Assim, a proximidade de “A™:
(1/19) x 1000 = 52,6 e assim sucessivamente.

Resta acrescentar que valores altos de proximidade indicam uma melhor capacidade dos
nos se ligarem com os restantes actores da Rede. Assim, “J” possui 0 Grau de Proximidade
mais alto (66.7). A situacdo contraria, ou seja, um Grau de Proximidade baixo indica que o
actor ndo se encontra bem posicionado dentro da sua Rede. E o que acontece com “E”, que
tem um Grau de Proximidade de 35.7.

Agora, regressando ao nosso exemplo “Rede de interacgdes”, calculamos o Grau de
Proximidade com o UCINET, seguindo estes passos:
1. Na barra de menus escolhemos o caminho Network > Centrality > Closenness (Figura
39).
2. Na janela que aparece, escolhemos o ficheiro “Rede de interaccfes” e pressionamos
“Abrir”.
3. Pressionamos “Ok” e imediatamente abre-se uma nova janela com os indicadores
solicitados (Figura 40).

4. Estes indicadores podem ser copiados Edit > Copy e/ou guardados File > Save as.
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Figura 39 — Procedimento para obter o Grau de Proximidade

Medidas de Centralidade 25



21 Outjual Ling 04
Wi Bae

Skl &

CLEENES CENTAALITT

T EEEEEEEEEEREEETE

r T 24 pea TEIT g% F a2
i ¥

Figura 40 — Resultado do Grau de Proximidade da “Rede de interac¢des”

Os resultados obtidos na Figura 40 mostram-nos dois tipos de proximidade (inClosenness
e outClosenness) que se referem ao Grau de Proximidade de Entrada e de Saida; tomaremos
0 Grau de Entrada como referéncia principal. Assim, podemos ver que A02 obtém o maior Grau
de Proximidade, com um valor de 19.231 e que os nés soltos (A07, A013, A015, A04) tém o

Grau mais baixo, com 6.250 (Quadro 9).

D Gr.au' de
Proximidade

A02 19.231
PO1 18.987
Al2 18.519
AO01 18.293
All 17.857
A06 17.857
AO05 17.647
AO03 17.647
A09 17.647
Al4 17.442
Al10 17.241
AO08 16.854
AQ7 6.250

Al13 6.250

Al5 6.250

A04 6.250

Quadro 9 — Resultados do Grau de Proximidade da “Rede de interac¢des” por no
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Neste indicador, o programa UCINET também nos mostra as Estatisticas Descritivas do

Grau de Proximidade (Quadro 10). Estes indicadores gerais interpretam-se da mesma maneira

que interpretdmos os indicadores de Centralidade e de Intermediacdo, mas sempre tendo em

conta que estes valores sao de Proximidade.

7. Criacao de Redes e Atributos multiplos

7.1.

Estatisticas Grau de
Descritivas Intermediacao
Média 15.015
Desvio-padrao 5.093
Soma 240.222
Variancia 25.940
Minimo 6.250
Maximo 19.231

Quadro 10 — Estatisticas descritivas gerais do Grau de Proximidade

Criacao de Redes multiplas

Ha situacdes que requerem a andlise de diferentes Redes, ou porque a propria analise

assim o exige ou para comparar as caracteristicas de cada uma delas. O primeiro passo seria

criar um ficheiro para cada Rede, como ja temos visto, e em cada uma assinalar atributos

diferentes, com a consequente criacdo de mais ficheiros.

Para fazer isto com o UCINET, que nos permite inserir Folhas de Calculo (Spreadsheet)

novas, procedemos do seguinte modo:

1.

de interacgdes”).

“Rede de interaccdes 1” (Figura 44).

Posteriormente, seguimos o caminho Edit > Insert sheet (Figura 41).

nome “Rede de interac¢des 2" (Figura 42).

Quando estivermos na Folha de Célculo, abre-se o ficheiro criado anteriormente (“Rede

Imediatamente, o programa pede um nome para a janela. Neste caso, introduzimos o

Para poder distinguir uma Rede da outra, trocamos o nome da primeira Folha de
Célculo, posicionando-nos na primeira janela, seguindo o caminho: Edit > Rename
sheet (Figura 43).

Ao abrir-se a janela que nos pede o novo nome da Folha de Célculo, escrevemos
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Figura 41 — Procedimento para inserir
uma nova Folha de Célculo
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Figura 43 — Procedimento para mudar o
nome de uma Folha de Calculo

| 05 sy ot e g e s~ = % |

I

I I I I

Po Lo

=
& el

[reyer

Figura 42 — Designacéo da nova Folha
de Calculo
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Figura 44 — Atribuicao do novo nome a
Folha de Célculo

Agora, para poder criar outra Rede que possamos introduzir na nova Folha de Calculo, e

seguindo o mesmo exemplo da “Rede de interac¢des”, vamos supor que, passado algum

tempo, voltamos a analisar as interac¢des deste grupo de alunos, por exemplo, no fim do ano

lectivo. O Quadro 11 mostra as novas interac¢des registadas.

Actor

Interaccdes

AO01 A02, A0S, A09, PO1

A02 A01, A03, A06, AD9, All, A12, PO1

A03 A02
A04 AO03
A05 AO01, A02, A12, Al4, PO1
A06 A05
AO07 AO6

A08 A02, Al4, PO1

A09 A01, A02, A12

A10 All, A12, PO1

All A02, A10

Al2 A02, A09 PO1

Al13 A08
Al4 P01, A15
Al15 Al4

PO1 AO01, A02, AO3, AD5, A06, A0S, Al10, All, A12, Al4

Quadro 11 — Resultados das novas interac¢cdes entre os actores
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Assim, ao introduzir estes resultados na Folha de Calculo, seguindo o mesmo
procedimento visto anteriormente, e apds termos preenchido com “zeros” os espacos vazios
(pressionando o icone “Fill"), temos a nova matriz tal como se apresenta na Figura 45, Depois,
guardamos as modificac6es através de um dos seguintes procedimentos:

1. Simplesmente pressionamos Ctrl + S.

2. Pressionamos o terceiro icone, a contar da esquerda para a direita.

3. Ou, seguimos o caminho File > Save.
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Figura 45 — Preenchimento da nova matriz

Neste caso, ja ndo é necessario voltar a criar um novo ficheiro, pois ja o temos (“Rede de
interacgBes”), posteriormente fechamos a janela e podemos ilustrar a nova Rede, mas antes
veremos como introduzir atributos mdltiplos para que desta maneira possamos ter graficos

mais interessantes.

7.2. Criacao de Atributos maultiplos

Para fazer isto, devem-se seguir estes passos:

1. Abrimos o ficheiro no qual tenhamos introduzido o atributo “género”, “Rede de
interac¢des (Género)”.

2. Adicionamos uma coluna por cada atributo que vamos acrescentar, neste caso,
inserimos o nimero 2 porque s6 vamos introduzir um novo atributo (mas poderiam ser
mais) (Figura 46).

3. Com os dados do Quadro 12, agrupamos as idades da seguinte maneira: grupo 1
compreende as idades dos 20 aos 24 anos, o0 grupo 2 dos 25 aos 29 anos e o grupo 3,
com 30 anos ou mais. Deste modo, assinalamos o atributo idade para cada um dos
actores (Figura 47).

4. Guardamos as modifica¢des seguindo o procedimento visto anteriormente.
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Figura 46 — Procedimento para
acrescentar uma nova coluna para
atributos

Figura 47 — Designacéao do atributo
“idade” para cada actor

Actor Idade
A0l 23
A02 22
A03 26
A04 28
A05 20
A06 30
A07 28
A08 25
A09 30
A10 32
All 31
Al2 23
Al13 22
Al4 25
Al15 24
PO1 30

Quadro 12 — Idades dos actores

Agora que temos um ficheiro com as Redes e outro com os atributos, podemos passar a

criacdo dos gréficos e, posteriormente, a analise das Redes com os indicadores.

7.3. Criacao de graficos com Redes e Atributos multiplos

Para poder criar este tipo de graficos, primeiro é necesséario abrir o NetDraw 2.28. De
seguida, abrimos o ficheiro “Rede de interac¢des”. Imediatamente, o programa abre um grafico
semelhante ao que fizemos anteriormente. Para poder ter outra vista do grafico, pressionamos

0 oitavo icone a contar da esquerda para a direita (Figura 48). Também se poderéo utilizar os
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restantes icones para termos diferentes vistas do gréafico, pelo que o seu uso dependera da

decisé@o do leitor. Neste caso, seleccionamos “Disposi¢cdo em circulo”. De imediato, o gréafico

muda (Figura 49).

du - fre

Figura 48 — icone para gerar diferentes
vistas do grafico

Figura 49 — Nova vista do gréfico

Agora, ao seleccionar o separador “Relacdes” (Rels.), para poder visualizar a Rede criada

anteriormente, temos que seleccionar a caixa onde diz “Rede 2” (Figura 50).
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Figura 50 — Seleccionar a nova Rede para criar o grafico

Imediatamente, o grafico muda; podemos ver, por exemplo, que ja ndo existem nés soltos

como na “Rede 1" (Figura 51). Se quisermos regressar a “Rede 1", sé temos que seleccionar a

caixa respectiva neste separador.
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Figura 51 — Grafico novo, “Rede 2"

Para poder visualizar o grafico da Rede com os atributos criados, seguimos o procedimento
visto anteriormente e, da mesma maneira, podemos diferenciar por cores e pela forma da

figura (Figura 52).

m i

Figura 52 — Diferenciacdo dos ndés por cor e forma de acordo com os atributos

A vantagem de termos mudltiplos atributos consiste na possibilidade de diferenciar todos os
actores ou grupo de actores, utilizando uma cor para um atributo e uma forma para outro
(Figura 53).
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Figura 53 — Diferenciagdo dos nés utilizando os atributos

7.4.

Para obter os indicadores de cada uma das Redes procedemos da mesma maneira, como

Indicadores de Redes multiplas

anteriormente, a Unica diferenca é a forma como se apresentam os dados.

Deste modo, para o Grau de Centralidade seguimos: Network > Centrality > Degree. Os

resultados surgem como na Figura 54, onde podemos observar que 0 programa primeiro

mostra os resultados da “Rede 1" e posteriormente da “Rede 2", cada uma com as Estatisticas

Descritivas respectivas. Também podemos ver o Grau de Centralizacdo de cada uma das

Redes.
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Figura 54 — Grau de Centralidade para Redes multiplas
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Infelizmente, os Graus de Intermediacdo e de Proximidade ndo se podem visualizar da
mesma maneira, como o Grau de Centralidade, pois o programa s6 mostra a primeira Folha de
Célculo do ficheiro, ou seja, s6 apresenta os resultados da “Rede 1". Assim, quando for
necessario obter estes indicadores, as Redes terdo que ser separadas em ficheiros diferentes.

Para exemplificar isto, a Figura 55 mostra uma nota que evidencia o que foi dito.
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Figura 55 — Grau de Intermediacdo para Redes multiplas

Até ao momento, explicitimos os passos para a construcdo de uma matriz, a criacdo de
um gréfico, a introducdo e a compreensdo dos atributos de cada n6é para facilitar a
interpretacdo da Rede e a criacdo de indicadores, quer para uma Rede com um ou varios
atributos, quer para manipular Redes multiplas. Estamos, agora, preparados para proceder a
Analise de Redes Sociais com um maior nidmero de nds, manipulando diversos atributos e

indicadores que nos permitam a compreensado de qualquer grupo social.
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8. Glossario de termos e conceitos

Grupo de individuos que, de forma agrupada ou individual, se
relacionam com outros, com um fim especifico. As Redes podem ter

Rede . ) ~
muitos ou poucos actores e uma ou mais classes de relagdes entre
pares de actores.

Grafo Nome técnico do grafico de uma Rede.

NoOs ou Actores

As pessoas ou grupos de pessoas que se agrupam com um
objectivo comum. Geralmente, os ndés ou actores representam-se
com circulos.

Tamanho da Rede

A soma de todos os n@s ou actores representa o tamanho da Rede.

Vinculo

Sao os lagos que existem entre dois ou mais nds. Os vinculos ou
relacdes representam-se com linhas.

Fluxo

Indica a direccdo do vinculo. Os fluxos representam-se com uma
seta que indica o sentido do fluxo.

Fluxos mutuos ou
bidireccionais

Séo fluxos que contém setas em ambos os sentidos.

Fluxos dirigidos ou
unidireccionais

Fluxo cuja direcgao s6 contém um sentido.

N6 solto

NG ou actor que ndo tem qualquer tipo de fluxo, o que por sua vez
implica a auséncia de vinculos.

Matriz

Conjunto rectangular de elementos dispostos em linhas horizontais
(filas) e verticais (colunas).

Matriz quadrada

Matriz que contém o mesmo namero de filas e de colunas.

Matriz simétrica

Matriz onde as relacdes entre os nds se dado de maneira
bidireccional.

Matriz idéntica

Matriz que contém o mesmo nome e numero de actores tanto nas
filas como nas colunas.

UCINET

Programa compreensivo para a analise de Redes sociais e outros
atributos. O programa contém varias rotinas analiticas para Redes.
Permite a andlise geral e multivariada, contém ferramentas para criar
escalas multidimensionais, andlises de correspondéncia, andlises de
factores, andlises de grupos e regressao mdltipla. Para além disto, o
UCINET contém uma plataforma para a manipulacdo de dados e
ferramentas de transformacdo para realizar procedimentos de
teoremas gréficos com uma linguagem algébrica entreposta por
matrizes.

NetDraw

Programa utilizado para ilustrar Redes Sociais. Usa diferentes tipos
de algoritmos para criar graficos a duas e a trés dimensdes. O
NetDraw é capaz de ler ficheiros criados no UCINET. Os graficos
que cria podem ser guardados em diferentes formatos (BMP, WMF,
JPG).

Atributos

Caracteristicas dos nés que permitem identificar cada actor ou grupo
de actores dentro de uma Rede, por exemplo, a idade, o género, a
profisséo, etc.

Caminhos
geodésicos

Distancia (nimero de vinculos) entre um no e outro.
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